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1. Day 1: Desktop GIS

A geographic information system (GIS) is a system designed to capture, store, manipulate,

analyze, manage, and present spatial or geographic data. GIS is used to display and analyze

spatial data which are tied to databases. This connection is what gives GIS its power: maps

can be drawn from the database and data can be referenced from the maps. When a database

is updated, the associated map can be updated as well. GIS databases include a wide variety

of information including: geographic, social, political, environmental, and demographic.

GIS uses layers, called "themes," to overlay different types of information, much as some

static maps use mylar overlays to add tiers of information to a geographic background. Each

theme represents a category of information, such as roads or forest cover. As with the old

mylar maps, the layers which are underneath remain visible while additional themes are

placed above.

GIS Systems work with many different types of data. Vector data is stored as a series of X,

Y coordinate pairs inside the computer’s memory. Vector data is used to represent points,

lines and areas. Illustration figure vector data shows different types of vector data being

viewed in a GIS application. In the tutorials that follow we will be exploring vector data in

more detail.

Figure 1.1 Vector Layer Data Map
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Vector data is used to represent points (e.g. towns), lines (e.g. rivers) and polygons (e.g.

municipal boundaries).

Raster data are stored as a grid of values. There are many satellites circling the earth and the

photographs they take are a kind of raster data that can be viewed in a GIS. One important

difference between raster and vector data is that if you zoom in too much on a raster image, it

will start to appear ‘blocky’ as illustrations figure raster data and figure raster data zoom . In

fact these blocks are the individual cells of the data grid that makes up the raster image. We

will be looking at raster data in greater detail in later tutorials.

Figure 1.2 Raster Layer Data Map

Raster data are often images taken by satellites. Here we can see mountains in the Eastern
Cape.

Figure 1.3 Raster Layer Data after zooming
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The same raster data, but this time zoomed in. The grid nature of the data can be seen

There are some software to perform this function of GIS like QGIS, SAGA GIS, UDig GIS,

DIVA GIS, GRASS GIS, ArcGIS ETC.

So, start working with QGIS.

The course assumes that you have little or no prior experience with theoretical GIS
knowledge or the operation of a GIS program.

Limited theoretical background will be provided to explain the purpose of an action you will

be performing in the program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and

how to harness their power via QGIS.

1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to

fulfil some or all commonly used GIS functions. Why should anyone be using QGIS over

some other GIS software package?

Here are only some of the reasons:

It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero

money. No initial fee, no recurring fee, nothing.

It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope

it will be included in the next release. You can sponsor the development of a feature, or add it

yourself if you are familiar with programming.

It’s constantly developing. Because anyone can add new features and improve on existing

ones, QGIS never stagnates. The development of a new tool can happen as quickly as you

need it to.

Extensive help and documentation is available. If you’re stuck with anything, you can turn to

the extensive documentation, your fellow QGIS users, or even the developers.

Cross-platform. QGIS can be installed on MacOS, Windows and Linux.

Now that you know why you want to use QGIS, we can show you how. The first lesson will

guide you in creating your first QGIS map.
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1.2 Hands-on Manual

To create basic map and to change symbology the following steps to be followed

1.2.1 Working with vector data

Vector data is arguably the most common kind of data you will find in the daily use of GIS.

It describes geographic data in terms of points, that may be connected into lines and

polygons. Every object in a vector dataset is called a feature, and is associated with data that

describes that feature.

The goal for this lesson: To learn about the structure of vector data, and how to load vector

datasets into a map. For this we required shape files.

The Shape file is a specific file format that allows you to store GIS data in an associated

group of files. Each layer consists of several files with the same name, but different file types.

Shape files are easy to send back and forth, and most GIS software can read them.

Before you can add new vector data, you need a vector dataset to add it to. In our case, you’ll

begin by creating new data entirely, rather than editing an existing dataset. Therefore, you’ll

need to define your own new dataset first.

You’ll need to open the New Vector Layer dialog that will allow you to define a new layer.

a) Navigate to and click on the menu entry Layer ‣ Add layer ‣ new vector file Layer.

b) Open your shapefile in Qgis as shown in Figure 14

Figure 1.4 Opening New Vector Layer

AS you click on brows data, click on all file and search for shape files, press the control and

select all shapefile that store by extension .shp.

For single shape file there are four to five file are created with different extension like
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.shx— shape index format; a positional index of the feature geometry to allow seeking

forwards and backwards quickly

.dbf — attribute format; columnar attributes for each shape, in dBase IV format

.prj — projection format; the coordinate system and projection information, a plain text

file describing the projection using well-known text format.

Here, we using 3 shape file one for point that we are showing by data of school, in 2nd

shapfile we are showing data about the road and in last shapefile we taking data of electoral

ward.

Merge these layers to single layer shown in Figure 111 Click on open you see following map

on map view window.

Steps:

a. First Open QGIS And OPEN all 3 Shape file in Qgis as shown in Figure 15, Figure 17

and Figure 19.

b. Map containg all the three layers like as shown in Figure 111 this map contain

information about point, line and polygon etc.

c. For points open school data .shp file shown in Figure 15, for lines open

road_network.shp file shown in Figure 17 and for polygon open electoral wards for cpt.shp

file as shown in Figure 19.

d. After opening points,, lines and polygon as .shp files in Qgis you can see the result of

each shape file  as  displayed  in Figure 16, Figure 18 and Figure 110.

Now if you want to know more about point information , click on school data layer and

deselect the other layer then you will see only data of points .
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● Go to properies(of road _network layer)->Style ->Categorized

● Click on the dropdown that says Single Symbol and change it to Categorized

In the new panel, change the Column to Type .

● Click the button labeled Classify:

as you click on classify you will see all the types of road i.e Emergency, Highway, Major

Road & Minor Road here we can chage the road type by choosing a symbol of your own

choice(eg solid , Dashed )

● click on Apply and Ok then you will see a below window
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Do the same procedure for school data layer

● School data layer-> properties-> Style->Categorized->column ->type->Symbol

Then you can change the symbols of all school you want to represent to differentiate from

each other (Secondary, Private, and Higher Secondary & Degree Colleges).

● click on Apply and Ok then you will see a below window

● Then GO next Go to the Labels tab.

● Click on the dropdown that says No Label and change it to Show labels for this Layer

then click on Buffer, in Labels  tab you can change the font size of your labels

In buffer you can change the size of buffer , color, transparency , color , blend mode
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● Click APPLY and OK.

You’ll see something like this:

1.2.2 Buffers in GIS

A buffer is a reclassification based on distance: classification of within/without a given

proximity. Buffering involves measuring distance outward in directions from an object.

Buffering can be done on all three types of vector data: point, line, area. The resulting buffer

is a polygon file.

Most often buffers are measured in uniform distance. For example, creating a 50′ buffer

around all rivers. A buffer based on different distances is called a variable buffer.
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Click the arrow (or plus sign) next to School_data in the Layer list, you’ll see the categories
explained:

From above work we can easily categories type of school and name of school

Do same steps for Road Network after that map will looks like as below:

▪
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1.2.3 The Layout Manager

QGIS allows you to create maps. For this, there is Layout Manager.

Click on the Project Layout Manager menu entry to open this tool. You’ll see a blank Layout

manager dialog appear.

● Click the Add button and give the new layout the name of Swellendam.

● Click OK.

● Click the Show button.

Whichever route you take to get there, you will now see the Print Layout window:

1.2.4 Basic Map Composition

In the Print Layout window, check that the values under Composition ‣ Paper and Quality are

set to the following:

● Size: A4 (210x297mm)ientation: Landscape

● Quality: 300dpi

● This create blank page layout in the way you wanted it, to add map in this layout

Click on the Add New Map button:

With this tool activated, you’ll be able to place a map on the page.

● Click and drag a box on the blank page:

The map will appear on the page.

● Move the map by clicking and dragging it around:
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1.2.5 Adding a Title

● Click on this button:

● Click on the page, above the map, and a label will appear at the top of the map.

Resize it and place it in the top center of the page. It can be resized and moved in the

same way that you resized and moved the map. As you move the title, you’ll notice that

guidelines appear to help you position the  title in the center of the page.

However, there is also a tool to help position the title relative to the map (not the  page):

● Click the map to select it.

● Hold in Shift on your keyboard and click on the label so that both the map and the

label are selected.

● Look for the Align button and click on the dropdown arrow next to it to reveal

the positioning options and click Align center:

1.2.6 Adding a Legend

● Click on this button:

● Click on the page to place the legend, and move it to where you want it. Then Map

Look like as shown in Figure 1.10 after Exporting Your Map

● Now if you want to export map, see the export buttons near the top left corner of the

Layout window:

The button on the left is the Print button, which interfaces with a printer. Since the printer

options will differ depending on the model of printer that you’re working with, it’s probably

better to consult the printer manual or a general guide to printing for more information on this

topic.
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The other three buttons allow you to export the map page to a file. There are three export

formats to choose from:

● Export as Image

● Export as SVG

● Export as PDF

Exporting as an image will give you a selection of various common image formats to choose

from. This is probably the simplest option, but the image it creates is “dead” and difficult to

edit.

The other two options are more common.

If you’re sending the map to a cartographer (who may want to edit the map for publication),

it’s best to export as an SVG. SVG stands for “Scalable Vector Graphic”, and can be imported

to programs like Inkscape or other vector image editing software.

If you need to send the map to a client, it’s most common to use a PDF, because it’s easier to

set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a

program that allows them to import and edit this format.

For our purposes, we’re going to use PDF.

● Click the Export as PDF button:

● Choose a save location and a file name as usual.

● Click Save.

● Close the Layout window.
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● Save your map.

● Find your exported PDF using your operating system’s file manager.

● Open it.

● Bask in its glory.

1.3 Working with raster data

In the below Figure 121 we have uploaded Nature Earth raster file of .Tif extension(i.e

NE1_50M_SR.Tif) , if you dont have the Raster data set you can download the it from

https://www.naturalearthdata.com/downloads/50m-raster-data/ you will get zip file containing

all the supported raster files just unzip and use it wherever required .

Band Rendering
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o Right click on Raster Layer(i.e NE1_50M_SR )-> Properties-> Style-> Rendering

Singleband datasets if your dataset has a color map, it will be displayed with the color map

rendering using the color map renderer using the colors stored in tye color map as shown in

Figure 1.23.

o

o

o

o

o

o
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Another Example Explained :

● Use the Add Raster Layer button to load the new raster dataset.

● Open the Layer Properties dialog for the SRTM (any file which support raster

layer)layer by right-clicking on the layer in the Layer tree and selecting Properties option.

● Switch to the Symbology tab

These are the current settings that QGIS applied for us by default. Its just one way to look

at a DEM, so lets explore some others.

● Change the Render type to Singleband pseudocolor, and use the default options

presented.

Figure 1.25 Single band rendering

● Click the Classify button to generate a new color classification, and click OK to

apply
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this classification to the DEM.

Figure 1.27 Result of raster Layer

You’ll see the raster looking like this as shown in Figure 1.28. This is an interesting way of

looking at the DEM, but maybe we don’t want to symbolize it using these colours.
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● Open Layer Properties dialog again.

● Switch the Render Type back to Singleband gray.

● Click OK to apply this setting to the raster.

You will now see a totally gray rectangle that isn’t very useful at all.

This is because we have lost the default settings which “stretch” the color values to show

them contrast.

Let’s tell QGIS to again “stretch” the color values based on the range of data in the DEM.

This will make QGIS use all of the available colors (in Grayscale, this is black, white and all

shades of gray in between).

● Specify the Min and Max values as shown below.

● Set the value Contrast enhancement to Stretch To MinMax:

But what are the minimum and maximum values that should be used for the stretch? The ones

that are currently under Min and Max values are the same values that just gave us a gray

rectangle before. Instead, we should be using the minimum and maximum values that are

actually in the image, right? Fortunately, you can determine those values easily by loading the

minimum and maximum values of the raster.

● Under Load min / max values, select Min / Max option.

● Click the Load button:
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● Click OK to apply these settings to the image.

You’ll now see that the values of the raster are again properly displayed, with the darker

colors representing valleys and the lighter ones, mountains:

1.4 Working with geopprocessing and geometric tool of vector layer

1.4.1 To calculate Centriod of polygon

A centroid is per definition a point layer and not a polygon. Therefor you need to create a

new layer or use same polygon shapefile for this, which is easy as pie in QGIS 1.8 and higher

versions.

● Load in your polygon
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● Go to the menu -> Vector -> Geometry tools -> polygon centroid and create a centroid
point layer

● Export the coordinates of the created Centriod to the attribute table by clicking on ->

vector Menu -> Geometry tools -> Export/Add geometry columns.

● After centoriod calculation shows following Screen

1.4.2 Calculating heatmap for available vector data

HeatMap: Select the Heatmap tool button to open the Heatmap dialog.
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● In the Input point layer field, select airports from the list of point layers loaded

in the current project.

● Specify an output filename by clicking the button next to the Output raster

field. Enter the filename heatmap_airports (no file extension is necessary).

● Leave the Output format as the default format, GeoTIFF.

● Change the Radius to 1000000 meters.

● Click on [OK] to create and load the airports heatmap

QGIS will generate the heatmap and add the results to your map window. By default, the

heatmap is shaded in greyscale, with lighter areas showing higher concentrations of airports.

The heatmap can now be styled in QGIS to improve its appearance.
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Open the properties dialog of the heatmap_airports layer (selects the layer heatmap_airports,
open the context menu with the right mouse button and select Properties).

● Select the Style tab.

● Change the Render type to ‘Singleband pseudocolor’.

● Select a suitable Color map , for instance Yellow Or Red.
● Click the [Load] button to fetch the minimum and maximum values from the raster,
then click the [Classify] button.
● Press [OK] to update the laye

The final result is shown in Figure 1.36

1.4.3 Calculating Intersection of Vector Layer
Overlay layers such that output contains areas where both layers intersect.

● Go to vector menu-->Geoprocessing Tools-->Intersect then it gives following
Window

● Give Input Layer and Intersect Layer and Press Run Button It gives Intersect of Two
layer.
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1.4.4 Calculating Union of vector layer

For drawing polygon, we need to select toggle edit option as shown in snapshot. Overlay

layers such that output contains intersecting and non-intersecting areas.

● Open Poly.shape and electoral_wards_for_cpt.shp in QGIS

● Go to vector menu-->Geoprocessing Tools--> Union then itg ives following

Window

● Give Input Layer electoral_wards_for_cpt.shp  and Union Layer as Poly and Press

Run Button It gives Union of Two layer
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● It gives following output as shown in Figure 1.41

1.4.5 Calculating Difference of vector layer:
Overlay layers such that output contains areas not intersecting the clip layer.

● Open Poly.shape and electoral_wards_for_cpt.shp in QGIS

1.4.6 Assignment:

1. How to add “Google map” on map view?
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2. For example, you are an estate agent and you are looking for a residential

Property in Mumbai for clients who have the following criteria:

● It needs to be in Mumbai

● It must be within reasonable driving distance of a school (say 1km).

● It must be more than 100m squared in size.

● Closer than 50m to a main road.

● Closer than 500m to a restaurant

1.5 Creating basic map in UDig

1.5.1 Introduction

Welcome to the User-friendly Internet Desktop GIS (uDig) application! uDig is collaborative

effort brought together by a diverse project management committee from organizations across

the world:

● Andrea Antonello HydroloGIS(Italy)

● Jesse Eichar, Camptocamp(Switzerland)

● Jody Garnett, LISAsoft(Australia)

● Mauricio Pazos (Spain)

uDig was originally started by Refractions Research in Canada with funding from

GeoConnections Canada. uDig is intended to be used in conjunction with your existing

investment in spatial information.

Definition of UDig:

1. User friendly- Automatic Integration.

a. Desktop-

● Operating System Integrations

● Cut and Paste

● Drag and Drop

2. Internet

● OGC web map server

● OGC web feature server

● Catalogue

3. GIS

● Analysis Framework
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● Printing

● Customize

1.6 Overview of UDig

● UDig is an Open Source  (LGPL) desktop application framework.

● Built with eclipse rich client (RCP) technology

● Use Geotools as library

● Stand alone application

● Can be extended with plug-ins

● Also be used as plug- in unother application.

1.7 Hands-On Manual

1.7.1 Installing and Running The uDig Application

In this section, you will install and run the Eclipse Application, which will be used for
viewing map information.

Following are the Windows installation setps

1. Double-click the installer.

2. The installer will allow you  to install uDig into the directory of your  choice.
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3. We have a number of license agreements to click through.

4. By default uDig will be installed into your Program Files directory.

.
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5. Shortcuts will be created in your start menu.

6. Please wait while uDig is installed.

7. Congratulations you have installed uDig!
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We have a known issue telling Windows 7 that the installation was successful. Please

click “This program installed correctly”.

8. If you are working in a corporate environment with a firewall pleasreview the   Following

page for details on proxy configuration.

http://udig.refractions.net/confluence/display/EN/Running+uDig

1.8 The Workbench

Before we start playing with maps, let’s take a look at the default layout of the uDig

workbench and what some of the key components are. Shown below Figure 151 is a typical

session of uDig with the Map, Projects, Layers, and Catalog views labelled. These views will

be described further as we demonstrate their uses.

Figure 1.51 Workbench of uDig
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Figure 1.52 All Panels

1.9 Working with Files

● Create an empty Map by slecting File > New > New Map from the menubar.

● Drag and Drop the file palghar shapefile and pune shape file onto your open Map
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Do same for Palghar.shp file, then you will see the result shown in Figure 1.56.

Figure 1.54 Selecting Pune.shp from files
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Figure 1.56 Result of pune.shp and Palghar.shp

To appy grid and legend click on  layer tab then you can apply  Grid and Legend
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1.10 Import Directly to the Catalog

Earlier we learned how to work with content from the Catalog view, in this section we
will import content directly into the catalog.

1. On the Catalog View press the Import option for example shown in below

Figure 1.58.

2. On

Catalog panel Right click and press import and you will see all the loaded .shp files in catalog
view.

3. Select Other > Data and press Next.
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4. Please choose Web Map Server from the list and press Next.

.
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4. This time we are going to import an OpenGeo demo Web Map Server using the   following

Capabilities document:

http://demo.opengeo.org/geoserver/owsservice=wms&version=1.1.1&request=GetCapabilitis

5.  You can copy and paste the URL into the provided field

6.  Press Finish to import the Web Map Server into the Catalog view.

7 . Now that we have imported the WMS into the catalog we can add it to our Map. Please

Drag and Drop the bluemarble layer directly onto Map

8. Earlier we used the the layer view to reorder using the up and down buttons, this time

we will drag the layers into the right order. Select the Blue Marble layer in the layer view

and drag it to the bottom of the list.
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1.11 Changing Symbology of Created map

● Click on style icon on layer panel and go to the theme and make changes.

● Select opacity and Outline and click on apply

Figure 1.65 Changes in Theme

o
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Figure 1.66 Change Opacity

● Now you have some data on screen try the navigation tools along the top of the tool

palette. Zoom (keyboard short cut “z”)

● Click or drag the left button to zoom in , out right button to zoom out.  Pan( keyboard
short cut “p”)

● Click on drag move the display

Press the Mylar button in the Layers View. Select each layer and observe the effect.

Mylar will fade out all the layers except for the one selected.

2 Day 2: Data Acquisition

2.1 Exercise 1: How to create a new polygon?
Steps to be followed

● Open Google map in qgis.

● Add vector layer of types: polygon, line, point.

● Create a attribute table.

● Add row and column in table.

2.2 Exercise 2 : How to Georeferencing small parts of map with bas map?

Collect data by accumulating small region maps:

● Get base map for a region and sub maps (map of different parts of region)

▪ From gov. Site.

● Open region sub maps using Georeferencing to match the base map.
● Merge these layers to single layer.
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2.3 Exercise 3 : What are GPS traces? How to collect data from GPS traces?
How to open it in QGIS?

● Collect GPS trace data from google maps.
● Open “.kml” file in qgis.

2.4 Using QGIS

2.4.1 Create “.shp” file in QGIS from google map:

Open QGIS and go to “web”. Select “Open Layer Plugin” (if you don't find then

goto “plugin” then “Manage and install Plugins...” and search “Open Layer Plugin”, click

“install Plugin”, then checked square box against “Open Layer Plugin”). Then “ Google

Maps” ->” Google Physical”

a. Below is the view of Google Street on loading. Open the view and find the location

which you want to create data for. Here we will be capturing data for VJTI campus

b. Create a new Shapefile layer which is vector layer by selecting new shape  file  layer
from left panel as shown below.
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c. Save the shape file layer as shown

Figure 2.4:  Saving created Shape File

d. For drawing a polygon , we need to select toggle edit option as shown in snapshot.
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e. We can draw polygon using mouse left click. Each vertex of polygon we need to do

a left click. Go on drawing along the perimeter of polygon.

f. We finish drawing polygon when we again return to starting point. On finishing, do a

right click and popup appears to enter the details of properties of that polygon.
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g. Once you create polygon come back to starting point and just click the right mouse

button it will ask you to enter the attributes of polygon shown in the below Fig. At left most

corner.

Figure 2.8 Enter the attributes

h. Once all details of polygon are filled, the area is fully constructed
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i. We continue drawing the polygons similarly, now after drawing departments of

college, we move to draw passages which are shown as lines. This is done in similar way but

select line type when creating shape file.

j. Below is view after drawing lines
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Temporarily we can also disable any layer by unchecking it in layer panel. Below we  have

unchecked google street layer. But it is present. Its not deleted, We can again obtain  it by
checking

k. For identification of each object(point, line and polygon) we can show any of its

properties that will be visible on layer, This is done using right click->

properties->label. Select “Show labels for this layer” and label with gives you the

attribute of polygon with which you want to label.
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l. We can view properties/ attributes of each polygon using the option shown below.

Figure 2.15 View attributes of polygon
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m. Properties/attributes are as shown below.

16. New fields can also be added at
Any time by in properties window by selecting “new field” option in it as shown

below.
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Finally we get a shapefile which has data stored in it for each shape we draw in its

properties which can further be worked on. Below is final shapefile which we created. We

have changed the color of vjti_campus layer from blue to green.

2.5 Geo-referencing Steps:

For  georeferencing you first need to download a base map with which you will map all

the geo-points.

a. Url for base map: http://www.bmcelections.com/bmc-new-ward-maps/

link will download the file in jpg format. Convert it into tiff file.

b. After this you need the image with which you will map the geo-points with base map

Url: http://www.bmcelections.com/ward-no-1-bmc-elections-2017/

the above link will download the file. You need to crop the image and crop the map part.

c. Open QGIS. Layer-> add layer -> add raster layer. Select tiff file and click open.
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d. Then go to Raster Menu and click on Georeferencer. A Geo-Referencer window will
open. In that open your png file (Click on “open raster “ icon (first left-most)).

e. Now click on “add Geo-Point”->click on point which is to be mapped (circled)

and then select option “From Map Canvas”.
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f. Select point from Base map which matched with point on raster image. Then select
“OK”.
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g. Then we can see added point in GCP table.

h. Then click on settings. Keep Transformation type as Linear, Resampling method as

Nearest neighbour and Target SRS as 4326. Save your file path and file name and click on

OK.
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i. After that click on Start Geo Refrencing

j. Your tiff file be generated and you will come to know whether the selected
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points were proper or not.

2.6 GPS Traces

To collect trace data, enable Location on your mobile.

● Goto Browser and Login to your google account.
● Visit “https://www.google.com/maps/timeline?pb”.
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● Goto “Settings ” and select “Export to kml file”

● Save the “history-2018-10-01.kml” file.

59



Figure 2.31 Creating New Map

● Goto “https://www.google.com/maps/d/”. Tap on “Create new map” then goto “add

layer. Import kml file from saved folder.

● Open QGIS and goto “web”. Select “Open Layer Plugin” (if you don't find then

goto “plugin” then “Manage and install Plugins...” and search “Open Layer Plugin”, click

“install Plugin”, then checked square box against “Open Layer Plugin”). Then “ Google

Maps” ->” Google Physical”.
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● Goto “Layer” -> “add layer” -> “Add vector Layer ” Or Goto left panel select
first symbol for “add layer”. Then select “.kml” file -> Click “Open”

● “Select all Features” -> click “Ok”. You can see added layer in v”Layer panel” on left

side vertical bar. Right click on layer then select “zoom to layer”. GPS traces will be visible.
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Day 3: Working with QGIS

2.7 Introduction

A spatial query is a special type of database query supported by geodatabases and spatial

databases. The queries differ from non-spatial SQL queries in several important ways. Two of

the most important are that they allow for the use of geometry data types such as points, lines

and polygons and that these queries consider the spatial relationship between these

geometries.

QGIS serves spatial queries through Query Builder and Field Calculator.

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause

and to display the result in the main window. The query result can then be saved as a new

vector layer.

2.8 Questions

● How to load layers in QGIS?

● How to access attribute tables?

● In how many ways we can select particular region from given map and how?

● How to create buffer?

● How field calculator can be used?

● How to select particular attributes using query builder?

2.9 Hands-on Manual

2.9.1 Load the vector layer in QGIS:

1. Click layers

2. Add  layer

3. Add vector layer

4. Select the shape file of required data and click open.
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Your file will be opened in qgis. You can open multiple such files in qgis through same
procedure.

2.9.2 Accessing the attribute table

1. Right click on the attribute table

2. Open attribute table

Here all the attributes of that layer can be seen.
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2.9.3 Highlighting a particular region through attribute table:

1. Open attribute table of that layer.

2. Select the complete row of required data by double clicking the respective right-most serial
number

3.
Select
p

Pan

64



Map:Panning and Zooming with Maps, to move the map click and hold the left mouse

button and drag the map to a new place. You can also move the map North, South, East or

West using the pan arrows.

Pan Map icon

2.9.4 Selecting region through query

1. Open properties by right click on the layer.

2. Select general and at the end find the query builder button.
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Click query builder and select the fields required and form the query.

2.
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2.9.5 Buffers
Buffer is the region created around selected geometry with the given radius value. It can be

used for various application queries dealing with areas and other analysis.

1. select the layer for which buffer is to be made.

Here, select palghar layer

2. Go to plugins -> manage and install plugin

3. Search MMQGIS, if not installed, install it and select it and close.

4. Click MMQGIS -> Create buffer

Give
name
of the
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buffer, its radius and units

2.10 Exercise

2.10.1 Find out village roads from the given road maps

1. Load road shape file in QGIS.

2. Right click on shape file and select ‘Open Attribute Table’

3. Select all the rows to calculate length.(icon of select all rows

4. On menu bar select ‘Open field calculator’ or press ‘Clrl+I’.

5. Set

‘Output

field

name’ .

6. set

Output

field type to ‘Decimal Number (real)’.

7. Select ‘Geometry’ -> ‘$length’

8. Click on ‘OK’.
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New column with length field will be added to the attribute table.

2.10.2 Selecting ‘village roads’ from given data.

1. Open road vector layer in qgis.

2.

Right

click

on

layer .
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3. Select properties.

4. From the menu select ‘General’.

5. Click on ‘Query Builder’.

6. Double click on ‘road_type’ .

7. Click on sample

8. write the following query.

9. “Road_Type” = ‘village_road’.

10. Click on OK and close the window.
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2.10.3 Find out the intersection between two layers.

1. Click on Vector -> Geoprocessing Tools -> intersection

2. Set input layer and intersect layer.
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Figure 3.21 Set input and output layer for intersection

3. Click on run.

4. You will get the intersection of two layers.

Figure 3.22 Intersection of two layers
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2.10.4 Find out percentage of village covered by roads in that region.

1. Select the village where you want to find out the road coverage area.

2.

2. Find out the roads in that village. [Hint: use layer intersection process].

3. Open attribute table of intersection layer.

4. Find the total area of roads in that region by using ‘field calculator’.

5. Now you have area of region and total area of the roads.

6. Use following formula to find out the percentage area covered by the roads.

[total area of road] / [area of region] * 100.

7

. You will get the total percentage of village covered by the roads.
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Figure 3.25 Total percentage of village

2.10.5 Find out the villages which are connected by roads.

1. Install ‘Spatial Query Plug-in’

2. Vector -> Spatial Query

3. Select source features from Village data [as we have to select villages]

4. Set Reference feature as Road buffer layer

5. and feature = intersect

Figure 3.26: Set Reference feature in Spatial Query

6. Click on Apply and close it.
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Figure 3.27 Result after Reference feature

7. You will get the highlighted region where roads exist.

8. Click on village layer.

9.  On menu bar click on edit -> Copy Features.

10. Edit -> Paste features as -> New Vector Layer.

11. Give file name and click on okay.

12. You will get the villages connected by roads.

Figure 3.28 Villages connected by roads

.
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2.10.6 Find percentage area of taluka under watershed.

a. Open district shape file and watershed boundary shape file in QGIS. We need to click

on Layer-> Add Layer -> Add vector Layer. Add path of shp file and click on Add button.

Figure 3.29 Palghar District with Taluka Boundaries

Figure 3.30: Watershed Boundaries of Palghar
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b. Now select one polygon from district shp file as one taluka and copy it in one

different feature. For this step select one taluka polygon using select feature.

Figure 3.31 Selecting one taluka polygon using select feature

c. Now click on copy features from Edit menu. Then Again go to edit menu and click

on Paste Features as -> New Vector layer and fill details of new layer as layer name and file

name also select CRS as EPSG:-4326 - WGS 84. It will create new layer with only selected

taluka polygon.

Figure 3.32 New layer with only selected taluka polygon
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d. As we want watershed boundaries for only selected taluka we can remove rest of the

boundaries polygon using intersection. For this we need to perform intersection operation.

Go to Vector-> Geoprocessing Tools- > Intersection.

Figure 3.33 Watershed boundaries for  selected taluka

For intersection need to select 2 layers as Input layer and Intersection layer. Select taluka

layer as Input layer and watershed layer as intersection layer. We can give name to intersected

layer in Intersection field. Now click on run in background button.

Figure 3.34 Intersection of two layers
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After successful intersection new layer will be created as Intersection. For this layer all

attributes are combined.

e. Now we have intersected shp file with both taluka area and watershed boundary area.

(In attribute table AREA is for Taluka Area and AREA_2 is for watershed boundary area).

We need to find percentage area of taluka under watershed. So we need to add one more filed

in intersected layer as percentage cover.

So to add attribute open attribute table by right clicking on layer. In attribute table first enable

the edit mode by clicking on Toggle editing mode (or ctrl + E). Now Open field Calculator

and fill details as output field name as per_cover and select output fields type as Decimal

number and use formula for calculation as :- ("AREA_2" / "AREA" ) * 100 . And click on

OK.

Figure 3.35: Open field calculator

Now we have are percentage of area cover by each watershed boundary.

f. Now we need to find which watershed boundaries are covering more than 0.5% of

area of taluka.  So we need to use query builder.

To open query builder right click on layer and click on properties. And in source there is

button on bottom right corne as Query Builder. Make sure that your layer in not in edit mode

otherwise you will not able to open query builder.
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Figure 3.36 Query Builder

:

Now we can use the following query to check which watershed boundaries are covering more
than 0.5% of area "per_cover"  >=  0.5

Now click on OK.

Now you will get the watershed boundaries with area greater than 0.5% of taluka area.

Figure 3.37 Watershed boundaries with area greater than 0.5% of taluka area
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3 Day 4: ArcGIS

3.1 Objectives

At the end of this lab session, the participants will be able to :

1. Become member of Learn ArcGIS organization.

2. Create and save a map.

3. Create enriched layer.

4. Browse the feature layer.

5. Add fields to the existing table data and calculate the values in the newly added field.

6. Change the style of the map.

7. Run queries on the given data.

8. Bookmark the places.

9. Add layer as feature(hosted) layer.

10. Running analysis.

3.2 Assignments

1. Create and add a basemap of palghar.

2. Find out first 5 villages with largest areas in palghar.

3. Calculate male/ female ratio in each village of palghar:

4. Highlight villages which have male_female_ratio > 1

5. To find out % of villages covered by roads in Palghar.

6. Find villages which are not covered by roads.
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3.3 Introduction

3.3.1 What is ArcGIS?

A powerful mapping & spatial analytics software provided by ESRI (a global market leader

in GIS)

3.3.2 Which are ArcGIS Platforms?

We can make maps with 3 ArcGIS applications:

● ArcGIS online (SaaS)

● ArcGIS Pro (Desktop GIS)

● ArcMap

3.4 How to start with ArcGIS?

Create online account using Learn ArcGIS organization: If you only want to complete

lessons to practice ArcGIS Online analysis workflows, create an online account where you

will get 60-day membership. Your account and content will be deleted after 60 days.

ArcGIS trial: Request a free ArcGIS trial if you want to complete lessons that use multiple

ArcGIS applications. The trial provides access to the ArcGIS platform, including ArcGIS Pro

and other ready-to-use apps. At the end of your trial, you can choose to purchase

ArcGIS and keep items that you saved in ArcGIS Online.

3.5 What you can do with ArcGIS?

● You can use maps to explore data
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● Create and share maps and apps,

● Publish their data as hosted web layers.

3.6 How to start as a beginner

3.6.1 Create online account:

Follow these steps to create an online account-

a. To become a member of the Learn ArcGIS organization, Click on
https://learn.arcgis.com/en/become-a-member

b. Fill in first and last name and email-id. Accept the terms and conditions.

c. You will get confirmation message “Thank you. Please check your confirmation email

from ArcGIS Notifications to complete your membership.”

d. Check your email. Open an email and click on the link provided to finish setting up an

account.
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e. It will provide you with the username. Remember this. Set up a password.

f. Finish the process and click sign in. Your profile is complete now.

g. You are automatically signed in to the website.

3.6.2 Sign in with an ArcGIS account or a public account

Follow these steps to sign in with an ArcGIS account or a public account.

a. Click on https://www.arcgis.comor https://learngis.maps.arcgis.com From the
website, click the Sign In link at the upper right, access the sign in page directly from your
organization's URL, or access the sign in page directly from
https://www.arcgis.com/home/signin.html.
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b. Enter your user name exactly as it was spelled when you or your administrator created

your account. User name must be in the format firstname_lastname_LearnArcGIS

c. Enter your password exactly as you spelled it when you or your administrator created

your password. Your password is case sensitive.

d. Check the Keep me signed in option.

e. Click Sign In.

3.7 Begin with the basics

Using ArcGIS, You can create

● Maps
● Scenes
● Apps

And do much more like explore spatial data, solve a spatial problem, share a map, manage

data, view maps and scenes. In this assignment, we will see how to create  a map.

3.8 Get started with maps

Following figure shows steps to be followed to create a map:

.

a. Choose basemap

1 Sign.
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b. A basemap provides a background of geographical context for the content you want to
display in a map.

c. When you create

a new map, you can choose which basemap you want to use. you can either choose an area of

basemap from Atlas shown or create new map.

d. On the Ribbon, click on Map.

Figure  4.9 Ribbon

Choose Add Layer from File. We are going to upload a map from a shapefile of Palghar.

How to get shape file :

a. search for “palghar shape file in maharashtra census” on google.

b. Go to website

https://www.cse.iitb.ac.in/~pocra/MahaCensus_shapefile_data/MaharashtraCensus.html.
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c. From the list of all districts, select palghar and download the zip file.

Click on palghar district you will get Palghar.Zip folder which contains all files including
palghar.shp file

● palghar.cpg

● palghar.dbf

● palghar.prj

● palghar.qpj

● palghar.shp

● palghar.shx
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d. You can add layers to your map by importing data you have stored in a delimited text

file (.csv or .txt), GPS Exchange Format file (.gpx), GeoJSON file (.geojson or .json), or

shapefile (compressed into a .zip file). A layer from a file is stored in the map.

e. Click Choose File and locate the file on your computer.
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If You select only palghar.shp file You will get an erroer . As shown in below Figure 414

So to resolve error you have to import Palghar.zip folder containing all the supporting files

which you had been downloaded from the website .
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f. Click Import Layer.

g. Choose Radio button of ‘ Generalize features for web display’. And click on Import

layer option again.  This may take a while to load the layer.

h. Your layer is added to the map. With this we have created basemap after importing
file/folder  you will see a below window

You can save the map by clicking save option on the ribbon. Give the title and add tags to
save the map.
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3.9 Enrich a layer

Layer enriching retrieves information about the people, places, and businesses in a specific

area, or within a selected travel time or distance from a location. This feature enables you to

apply filters. You have to enrich layers when the base layer data is in text format and not in

the number format.

Follow the steps for enriching a layer.

a. Select palghar basemap and click on analysis. Select data enrichment.

b. Click on enrich layer

c. Here choose layer to enrich with new data. Basically our basemap layer.

d. Select variables which you want to add on in addition to exisitng data. ( This is

mandatory as it will not proceed with analysis without this)
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e. Give some unique name to the result layer created.

f. Click on run analysis. This may take a while. After Run Analysis you will see the
below window
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g. At the end, the enriched layer will be added to your content.

h. This layer will enable you to apply filters.

3.10 Features of a layer

a. Open a map. Click Details and then Contents.

b. To see information about features in a layer, takeover your mouse on the map.

c. Browse to the feature layer and click Show Table . The table appear at the bottom
of your map.
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d. The short forms of various attributes and its description is given here.
https://www.cse.iitb.ac.in/~pocra/MahaCensus_shapefile_data/Attribute.html. Click a
segment to see the details of it.

e. You can manipulate the table in the following ways to help you find the data you
want:

● Sort the attributes by clicking the column header and selecting Sort Ascending or Sort
Descending.

● You can hide columns to make room in the display for the attributes you need. To hide
or show attribute fields, click Options and click Show/Hide Columns. Check boxes to show
attribute columns. Uncheck boxes to hide them.

● You can add extra field by clicking options and then selecting area field.

● To add data to this field, click on field which you want to update and select
calculate.eg apply filter
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● Select arcade as you can write functions here to calculate area.

● Select functions and click on area. Test the function. And click ok. It will calculate
and update the rows for area column.

● Assigment : Let us find out first 5 villages with largest areas in palghar.

3.11 Change style of the map

a. You can change the style of the map & add the attributes.

b. If we want to change the colour of the map, click on options in select a drawing style

option. Select the required colour. Click ok. In this step we can Classify Data (Group data

into classes.), Draw features that have no value or values that don't fall within a class.
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c. Click on Done & Save the map.

Note: Use colors to represent your numerical or ranked data. Choose a theme that matches

your data to a particular color scheme. For example, show data like age or income with the

High-to-low theme that uses a simple light to dark color scheme.

3.12 Exercise: Calculate male/ female ratio in each village
of palghar

Solution:

a. Click on table right top side, then select add field as male_female_ratio as follow and
add new field.
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New field is added as last column in table as shown in below Figure 432

b. Click on male_female_ratio on that field which show you one menu, select calculate>
arcade.

male_female_ratio = $feature.tot_m / $feature.tot_f
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c. Click on ok. If you get an error where id = 164

d. You may check data from table, tot_f’s value at 164th row is =0.00 which is incorrect.

Correct it by double clicking on cell, you will get a textbox, enter value and hit enter. Value is
updated.

Note: you will be able to update the values in a table only if you have opened a map with full
edit control. Refer end of this section to open the map with full edit control.

e. Now calculate once again : (repeat step 3): Ratio is calculated and table is updated

with value as shown in figure.

f.

g.
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3.13 Open the map with full edit control.

a. Select add item > from my computer

b. Browse palghar.zip file which contain shape file, give tag and click on add item.

c. Open it in map viewer > add to new map with full editing control.
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3.14 Apply filter on palghar  data

a. which show villages which have  male_female_ratio > 1

b. Click on content. On palghar map, select filter.

c. Create an expression where male_female_ratio is greater than 1. Apply filter.

d. It will highlight the areas with male_female_ratio is greater than 1.

3.15 Bookmark the places

We can also Bookmark the places. It provides shortcuts to interesting places on a map. As a

map author, you create them based on the current location and scale of the map. When you

click a bookmark, the map zooms to that location.

a. To create a new bookmark: Open the map in Map Viewer. Navigate the map to the

location and scale you want to bookmark. Click Bookmarks , click Add Bookmark, and enter

a name for the bookmark.
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b. Go to an existing bookmark: Open the map in Map Viewer. Click Bookmarks and

click the name of the place you want the map to zoom to.

3.16 Applying filters and running query

a. Go to the layer and Click on filter. This will enable you to create query in the form of
expression.

b. Create a query where total working female population is greater than total working

male population.

c. You can change the color of the villages with largest population.

d. Assignment : Highlight the villages where total working female to total working male

is above 1.0

3.17 Adding layer as feature layer(hosted)

a. Verify that you are signed in and that you have privileges to create content and

publish hosted feature layers.

b. Open Content > My Content, click Add Item, and click From my computer.

c. Click Choose File or Browse (the button name varies by web browser) and find the

file on your computer.

d. Select the file and click Open.
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e. Shapefiles must be compressed as a .zip file containing at least the .shp, .shx, and .dbf

files.

f. If there are multiple shapefiles in the .zip file, they are all included in the feature

layer.

g. Type a title

h. Click Assign Category and select up to 20 categories to help people find your item.

You can also use the Filter categories box to narrow down the list of categories.

i. Type tag terms separated by commas. Tags are words or short phrases that describe

your item and help people find your item when searching. Federal land is considered one tag,

while Federal, land is considered two tags.

j. Leave the Publish this file as a hosted layer box checked. Note: If you uncheck this

box, your data file is added to My Content, but no hosted feature layer is published. You can,

however, publish the file later by clicking Publish on its item page.

k. The data file and the feature layer are separately added to My Content.
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3.18 Add a layer

a. Till now we have added only one layer.

b. You will add a layer on the top of the basemap layer. Here we are going to add a road

network of palghar on the top of basemap demographic layer of palghar.

c. To add layers from files. You can add layers to your map by importing data you have

stored in a delimited text file (.csv or .txt), GPS Exchange Format file (.gpx), GeoJSON file

(.geojson or .json), or shapefile (compressed into a .zip file). A layer from a file is stored in

the map.

d. If your CSV file, shapefile, or GeoJSON file contains a large amount of data, or you

want to create a layer that you can reuse in multiple maps, you can publish a hosted feature

layer instead of adding the file to the map.

e. Now Click on add a layer from file. In ‘Search for layers’ type the name which you

have specified while creating hosted layer. Click on open the map in map viewer and map

will be added to your content. You can select ‘open map in map viewer with full edit control’.

f. Your new layer is now added to your map.
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3.19 Change the style of new layer

a. You can change the style of the map to give the routes a brighter color and a thicker
line width.

b. In the Contents pane, point to the palghar and click the Change Style button.

c. The Change Style pane appears. Layers can have either a single symbol or multiple

symbols based on attribute information such as names or speed limits. Now, you're only

interested in showing the location of roads, not particular characteristics of each road, so

you'll continue to symbolize the layer with a single symbol.

d. For Location (Single symbol), click Options.

Figure 4.48 Location

e. The pane changes to provide multiple style options, such as the layer's transparency or

the range of map extents at which it is visible. You'll change the color and size of the symbol

itself.

f. Click Symbols, A window opens with a color palette and other options.

105



Figure 4.49 Showing Location

g. On the color palette, choose the blue color on the bottom row, fourth column from the
right.

Figure 4.50 select Color

h. After you choose the color, the six-character hexadecimal code changes to#004C73
for Line Width, choose 3 px.
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Figure  4.51 Line width

i. Click OK. The new line color and width are applied to the layer. In the Change Style

pane, click OK. Then, click Done. With the thicker, brighter symbol, the routes are

eye-catching and stand out.

3.20 Running Analysis

Exercise:  To find out % of villages covered by roads in Palghar.

Solution:

a. Open the palghar map and click on table.
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b. Add new village_area field into palghar table

.

c. Click on caluculate and then select arcade.

d. From arcade, select functions. Add formula: Area($feature,’square-miles’).

e. The values will be updated in the table.

f. Now add the road network with buffers to the map. We should have created in QGIS,

the road buffer network of palghar.

g. If you get a message like this “This dataset is too large to add directly to the map.

Instead, publish this data as a hosted layer, then add the hosted layer to the map.”. Then add a

hosted layer as mentioned in the “how to add hosted layer” section.
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h. Once we have added to road buffer network to maps.

i. We have to move the palghar demographic map down to show as a base and road

buffer on the top of it.

j. Select a map, click on more options and select move up/ down to move the map. The

maps are listed in the contents pane same as they are appear in the map view.

k. Next we will run the analysis to find out the answer to our query.

l. Click on analysis and then select manage data.

m. Click overlay layers.

n. Choose input layer as palghar basemap (enriched layer)

o. Choose overlay layer as road buffer network.

p. Choose overlay method as intersect.

q. Select output as areas.

r. Give some name to result layer.

s. Click on run analysis.

t. This will create a new layer as intersect layer.
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u. On this newly created layer, run analysis.

v. Choose summarize data and then summarize within.

w. Choose an area layer to summarize : polygon

x. Choose input layer as: palghar_enrich

y. choose overlay: intersect layer

z. Group by : census_201( This is village id. We want to add areas of all polygons here)

aa. Run analysis

bb. It will create a layer which will have a palghar enriched layer data and new field area
with polygon data.

cc. In the data table of this layer, we can directly add a field to calculate the percentage of

village area covered by roads.
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dd. In summarized data table add new field is road_village_area_ratio.

ee. Calculate its value as road_village_area_ratio = summerized area insquare miles /
village_area.
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